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Summary statement: Xenopus laevis tadpoles tend to swim in green-illuminated areas, a 14 

preference that likely arises out of circuit-level patterns of synaptic activity.  15 
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Abstract 16 

The Xenopus laevis tadpole has long been known to exhibit phototactic preferences, i.e. 17 

preferences to swim towards or away from visual stimuli. Of particular interest is the tendency 18 

for stage 48 Xenopus tadpoles to prefer green light but for older tadpoles to prefer blue light. 19 

Recent work has begun to characterize the timeline of development for Xenopus rod and cone 20 

cells with different light specificities, relating this developmental timeline to the shift in color-21 

guided phototactic preferences. Yet still little is known about the neural processing of color in 22 

the developing brain. The present study’s first experiment extends previous behavioral data, 23 

demonstrating that stage 48 Xenopus tadpoles’ phototactic preference for green light persists 24 

over extended testing periods and outside of forced-choice procedures. To further investigate the 25 

neural mechanisms underlying color processing in the developing brain, a second experiment 26 

used in vivo electrophysiology to examine neural activity in the optic tectum during the 27 

processing of color. To our knowledge, this is the first study comparing tectal activity in 28 

response to different colors of light. No differences in response to color were observed at the 29 

single-cell level, suggesting that the color of visual stimuli is likely encoded at the circuit level or 30 

higher. Finally, two distinct populations of neurons were identified based on the pattern of 31 

synaptic inputs they received during visual stimulation. Future studies will investigate the roles 32 

of these two neuronal types in the processing of visual stimuli.  33 
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Introduction 34 

The scientific study of color discrimination dates back to at least 1883, when Veit Graber 35 

first documented the phototactic preferences of salamanders (Graber, 1883; Laurens, 1911). The 36 

use of amphibian models for understanding visual processing tasks, such as color discrimination, 37 

continues over 100 years later (e.g. Rosencrans, 2018; Yovanovich, 2017). Indeed, the study of 38 

both visual circuit formation and the development of visual-related behaviors in amphibians has 39 

given rise to principles applicable to a wide range of vertebrates (e.g. Lambert, 2008), 40 

contributing to their continued relevance as model organisms today. 41 

Newly-developed behavioral assays provide evidence that Xenopus laevis tadpoles 42 

possess “true” color vision, meaning that they detect and respond to contrasts that can only be 43 

attributed to differences in color rather than brightness (Gravot, 2017). In fact, Xenopus tadpole 44 

color processing is remarkably similar to humans’ (Knorr, 2018), making the Xenopus visual 45 

system a viable model for studying the mechanisms that underlie subcortical color processing in 46 

humans.  47 

Beyond being a merely viable model, Xenopus is an attractive model to study color 48 

processing for several reasons. First, Xenopus vision gives rise to complex visually-guided 49 

behaviors (Dong et al., 2009). Additionally, the development of the retinotectal circuit, which 50 

gives rise to visually-guided behaviors, is highly stereotypical and well-characterized (Liu et al., 51 

2016). Finally, it is possible to make electrophysiological recordings from the optic tectum in 52 

vivo while visual stimuli are presented to the retina (van Rheede et al., 2015), allowing for 53 

visually-guided behaviors to be studied at the circuit level. 54 

 55 

Visually-guided behaviors 56 

 The color-guided behaviors of Xenopus laevis, the African clawed frog, mirror those of 57 

other amphibians including Rana temporaria, the European common frog; Rana pipiens, the 58 

leopard frog; and Bufo americanus, the American toad: in early development, these tadpoles 59 

prefer to swim towards green light, but as development progresses, they develop a phototactic 60 

preference for blue light over green (Muntz, 1963; Jaeger & Hailman, 1976). These preferences 61 

are robust, occurring regardless of animal sex, temperature, time of day, or time of year 62 

(Hailman & Jaeger, 1974). In Xenopus laevis, the behavioral shift to a blue preference is known 63 

to coincide with the development of blue-sensitive green cones (Parker et al., 2010). It has been 64 
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hypothesized that the early green preference of tadpoles exists to attract them towards green 65 

plants for feeding and shelter (Muntz, 1963; Jaeger & Hailman, 1976), while the later blue 66 

preference of tadpoles is less well understood. The blue preference may serve to draw tadpoles 67 

towards more brightly-illuminated areas as they move closer to the sky (Hailman & Jaeger, 68 

1974) or into deeper waters (Parker et al., 2010). 69 

Yet these experiments bring about several questions regarding the nature of tadpoles’ 70 

color-guided behavioral preferences. Jaeger and Hailman (1976) report a green preference 71 

among stage 46-48 Xenopus laevis tadpoles, yet cannot rule out the possibility that this 72 

preference is based instead on illuminance; tadpoles prefer swimming towards brighter stimuli 73 

and this preference overrode any color preferences observed. Thus, it has not been ascertained 74 

that Xenopus laevis tadpoles truly swim towards green light. 75 

Additionally, experimental approaches have employed a “forced-choice” mechanism 76 

whereby the animal is forced to make a choice by moving towards one stimulus or another. 77 

Animals were forced to make a choice by physical touch if they did not spontaneously choose 78 

one stimulus over the other and only those trials in which the animal passed a certain criterion 79 

line were scored (Muntz, 1963; Hailman & Jaeger, 1974; Jaeger & Hailman, 1973, 1976). In all 80 

cases, a trial was considered complete once the animal passed the criterion line. These 81 

experiments do not adequately test for visually-guided preferences. First, it is possible that the 82 

animal would generally prefer to remain stationary and has no strong phototactic preference 83 

either way. It is worth noting that Boycott et al. (1964) report that forcing Rana temporaria to 84 

make a decision altered phototactic preferences, though Chapman (1966) found no such effect 85 

with Rana catesbiana. Second, it is possible that animals’ initial color-guided preference may 86 

differ from their long-term color-guided preference. For example, perhaps an initial green 87 

preference would not persist over time. 88 

Finally, a subsequent experiment by Jaeger and Hailman (1976) involved measuring the 89 

density of Bufo americanus tadpoles at different locations in a pond, a naturalistic environment 90 

for a tadpole, and measuring the spectral qualities of the locations from which tadpoles were 91 

gathered. In this experiment, it was found that Bufo americanus tadpoles congregated in green-92 

illuminated regions of the pond, suggesting that Bufo americanus tadpoles prefer green-93 

illuminated regions over extended periods of time. However, interpretation of this result is 94 

confounded by the presence of green plants that serve as food for the tadpoles in the green-95 
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illuminated regions of the pond. It is possible that feeding motivated the observed behavior 96 

rather than innate color preferences.  97 

To address these issues, we developed a new behavioral test to measure tadpole color 98 

preference beyond initial phototaxis which does not involve forced-choice elements. Using this 99 

procedure, we characterized the color preferences of Xenopus laevis tadpoles over time. 100 

 101 

Neural processing of color 102 

 A question of basic scientific interest is how different colors are processed in the Xenopus 103 

tadpole’s brain. An understanding of the mechanisms involved in color processing may reveal 104 

the computations that give rise to color-guided behaviors. To date, no studies have directly 105 

addressed how color is processed in the tadpole brain. But given the similarity between Xenopus 106 

tadpoles’ color processing and humans’ subcortical color processing (Knorr, 2018), any insights 107 

into this process may yield knowledge of principles that underlie visual processing in 108 

mammalian midbrain structures, such as the superior colliculus. A midbrain structure that 109 

receives direct input from the retina, the superior colliculus orchestrates visual reflexes such as 110 

orienting or saccading towards a stimulus of interest (Schneider, 1969).  111 

 Studies of the non-human primate superior colliculus have found it sensitive to red-green 112 

contrast as well as blue-yellow contrast (White et al., 2009; Hall & Colby, 2014; Herman & 113 

Krauzlis, 2014). This information, taken together with the existence of a simple vertebrate that 114 

has similar color sensitivities to its mammalian counterparts, gives rise to interesting questions. 115 

For instance, because the optic tectum is an amphibian structure homologous to the superior 116 

colliculus in mammals, the Xenopus retinotectal circuit provides a unique opportunity to 117 

investigate whether color encoding and processing are evolutionarily conserved across 118 

phylogenetic classes. This knowledge would provide novel insights into the evolution of color 119 

vision. 120 

 121 

Implications for artificial intelligence 122 

 Synthetic biology is an emerging field to which dozens of reviews (e.g. Drubin et al., 123 

2007), special issues in journals (e.g. Hanson et al., 2019), and chapters in books (e.g. Luisi, 124 

2016) have been devoted. While great endeavors in synthetic biology have been made to 125 

synthetically model intracellular processes (Benner & Sismour, 2005; Drubin et al., 2007), 126 
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attention is increasingly turning to modeling multi-cellular circuits (Regot et al., 2011; Tamsir et 127 

al., 2011; Urios et al., 2016; Toda et al., 2018). Indeed, private sector corporations may also see 128 

promise in multicellular synthetic biology, as is reflected in recent patent filings for synthetic 129 

biology technologies (e.g. Prindle et al., 2016). 130 

 The retinotectal circuit is responsible for generating visually-guided behaviors in the 131 

Xenopus tadpole. Astoundingly, the retinotectal circuit is able to self-assemble into a circuit 132 

capable of perceiving and responding to the external environment in a matter of only 4-5 days 133 

(Liu et al., 2016). Studying the Xenopus retinotectal circuit provides the opportunity to learn 134 

more not only about the assembly of circuits, but also the interfaces between perception and 135 

action, an area that has long been (Horn et al., 1986; Goodale, 1990) and continues to be 136 

(Haazebroek et al., 2011; Palm, 2012) of interest to robotics and artificial intelligence. 137 

 138 

Materials and Methods 139 

Animals 140 

 All animal husbandry and experimental procedures were carried out in compliance with 141 

the University of Wyoming Animal Care and Use Policies. Tadpoles resulting from in-house 142 

breeding of adult Xenopus laevis frogs were reared in 10% Steinberg’s solution (0.067 KCl, 143 

0.034 Ca(NO3)2•4H2O, 0.083 MgSO4•7H2O, 5.8 NaCl, 4.9 HEPES; Liu et al., 2018a). Tadpoles 144 

were housed on a 12-hour light/dark cycle in white-walled incubators at 22C. All experiments 145 

were performed on stage 47-48 tadpoles (staging per Nieuwkoop & Faber, 1956). 146 

 147 

Behavioral testing 148 

 All green preference tests were carried out in a 5.5”-diameter circular petri dish filled 149 

with 75 mL Steinberg’s solution. The dish was placed on a computer monitor (HP ZR22W) that 150 

projected white light onto 75% of the dish floor and green light onto 25% of the dish floor. 10 151 

wild type Xenopus tadpoles were then pipetted into the dish, allowed to acclimate for one 152 

minute, and then recorded for one hour using a GoPro Hero 7 Black or GoPro Hero+ LCD video 153 

camera. At the end of every minute of recording, the number of tadpoles in the green and white 154 

sections of the dish was counted (Figure 1). Tadpoles from any given clutch were not tested 155 

more than twice. 156 
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 To control for schooling effects, in which the presence of one or a few tadpoles in one 157 

region of the dish attracts others to the same region, a parallel procedure was carried out under a 158 

similar protocol to that of the green preference test described above. However, in this control 159 

condition, the entire dish was illuminated with white light. An arbitrary 25% section of the dish 160 

was marked during analysis and the number of tadpoles in that section was counted over the 161 

course of an hour under the same methodological procedure. 162 

 Tadpole position was defined by the region where the tadpole’s eyes were. For example, 163 

during a green preference test, if both eyes were in the white section of the dish yet the tadpole’s 164 

tail was in the green section, the tadpole would still be counted as being in the white section. On 165 

the uncommon occurrence that one eye was in one section and the other eye was in another 166 

section of the dish, the tadpole was visually inspected and a determination was made as to which 167 

section a majority of the tadpole’s head resided in. 168 

 169 

In vivo whole cell electrophysiology  170 

 Xenopus tadpoles were prepared for in vivo electrophysiological recordings as described 171 

by Liu et al. (2018a). First, tadpoles were anesthetized with 0.01% tricaine methane sulphonate 172 

(MS‐222). Tadpoles were then transferred to a recording dish containing a bath of HEPES‐173 

buffered extracellular saline with the acetylcholine receptor blocker tubocurarine (comprised of, 174 

in mM: 115 NaCl, 2 KCl, 3 CaCl2, 3 MgCl2, 5 HEPES, 1 glucose, and 0.1 tubocurarine; pH 7.25; 175 

osmolarity: 255 mOsm). The tadpole was secured with insect pins before the skin overlying the 176 

brain was removed and the brain was filleted along the midline. Finally, a portion of the 177 

ventricular membrane covering the optic tectum was removed with a broken glass micropipette 178 

to provide access to tectal somas. It is worth noting that in the classic in vivo preparation, only 179 

tectal neurons from the superficial layers of the optic tectum are accessible for recording. 180 

 Once tadpoles were prepared for recording, whole cell patch clamp electrophysiology 181 

was conducted (Figure 2A-B) as described by Liu et al. (2018b). Incoming spontaneous synaptic 182 

activity (Figure 3) was recorded while the cell was held in voltage-clamp at -60 mV for a period 183 

of 370-400 seconds. Recordings were made while the tadpole received visual stimulation, 184 

described below. Tectal neurons were identified using the 60X water-immersion objective on a 185 

Zeiss Axio Examiner A1 upright microscope connected to a Hamamatsu CCD camera. Only 186 

neurons from the middle third of the tectum were selected for recording, to control for potential 187 
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variability along the rostral-caudal axis of the tectum. Consistent with selection techniques 188 

reported by Ciarleglio et al. (2015), unhealthy neurons, identified by their particularly granulated 189 

and dark coloration, were not recorded. Additionally, mesencephalic trigeminal neurons, 190 

identified by their large somas, light coloration, and visible nuclei (Pratt & Aizenman, 2009), 191 

were not selected for recording. 192 

Whole cell recordings were recorded using glass micropipettes (7-12 MΩ resistance) 193 

containing potassium gluconate internal saline (comprised of, in mM: 100 K-gluconate, 8 KCl, 5 194 

NaCl, 1.5 MgCl2, 20 HEPES, 10 EGTA, 2 ATP, and 0.3 GTP, pH 7.2; osmolarity: 255 mOsm; 195 

Liu et al., 2018b). While recording, an Axon Instruments MultiClamp 700B microelectrode 196 

amplifier (Molecular Devices, San Jose, CA) was used to measure signals, which were then 197 

digitized using a Digidata 1322A digitizer (Molecular Devices, San Jose, CA). Recordings were 198 

captured using pCLAMP 10.3 software. For inclusion in the dataset, cells needed to have <50 199 

MΩ access resistance during recording and needed to receive spontaneous synaptic input during 200 

the presentation of visual stimulation. 201 

 202 

Visual stimulation for whole cell electrophysiology 203 

 Tadpoles were presented with different colors of static, equiluminant visual stimuli while 204 

whole cell recordings were made (Figure 2C). During each recording, the tadpole was presented 205 

with four colors, red, grey, blue, and green, projected from a Samsung SP-P310ME projector. 206 

The first color presented was selected randomly, to control for possible duration-related effects 207 

of visual stimulation. Each color was presented for a total of 60 seconds while colors were 208 

interleaved by 30-second periods of projecting a black screen. It should be noted that the black 209 

screen projection was not truly black (i.e. the absence of light), and thus some light was still 210 

being projected onto the tadpole’s eye between colored stimuli. 211 

 212 

Data analysis 213 

 Electrophysiological data was analyzed using AxoGraph 1.7.2. Figure 4 was produced in 214 

ImageJ using the method described in Appendix A. All statistical analysis was performed in 215 

Microsoft Excel 2016 and R 3.5.3. 216 

 217 

Results 218 
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Tadpoles prefer green over extended time frames 219 

 If Xenopus tadpoles showed no preference between white and green, we would expect an 220 

average of 2.50 out of 10 tadpoles to be in the green section over the course of an hour, as the 221 

green section comprised 25% of the dish. However, across one-hour trials (N = 12), we observed 222 

significantly more tadpoles in the green section on average (median = 3.425; Wilcoxon signed 223 

rank test: V = 71, p = 0.009277). Indeed, this is illustrated qualitatively as well: Figure 4 shows a 224 

heat map of tadpole positions over time, illustrating where tadpoles were located over the course 225 

of a one-hour trial. Additionally, plotting a histogram of trial results reveals that results were 226 

clustered around 4.00, which is significantly higher than the 2.50 we would expect if tadpoles 227 

had no preference for or against green (Figure 5). 228 

 Subsequent analysis showed that the number of tadpoles in the green section did not 229 

differ significantly over the course of the hour, both qualitatively (Figure 6) and quantitatively 230 

(one-way ANOVA: F(59,660) = 0.80, p = 0.86). 231 

 232 

All-white dish test rules out schooling effects 233 

 The all-white control test resulted in an average of 2.05 tadpoles in the arbitrary 25% 234 

section of the dish over the course of an hour. This is similar to the value of 2.50 that would be 235 

expected with a random distribution of tadpoles throughout the dish, implying that schooling 236 

effects cannot account for the persistent number of tadpoles in the green. If schooling were 237 

occurring, we would expect more or fewer tadpoles to be present in the arbitrary region of the 238 

dish, as tadpoles would be drawn towards other tadpoles, either in that section of the dish or 239 

another section. 240 

 241 

No differences in synaptic transmission during presentation of different colors 242 

 The presentation of different colors was not associated with any differences in the 243 

following measures: frequency of synaptic events, amplitude of synaptic events, charge (pA*s) 244 

of synaptic events during the transition from black to the color, or charge (pA*s) of synaptic 245 

events during the transition from the color to black (N = 7 cells; one-way MANOVA: F(3,54) = 246 

0.56, p = 0.91; Wilk's Λ = 0.615). 247 

 248 

Two cell types identified based on pattern of synaptic input 249 
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 Analysis of electrophysiological recordings suggests the presence of at least two types of 250 

tectal neurons based on the pattern of synaptic input they receive. Some cells seemed to receive 251 

strong activity during the transition between two stimuli of highly contrasting luminance 252 

(“Contrast Detectors;” Figure 7A), and no patterned activity during the presentation of static 253 

stimuli, while other cells seemed to receive patterned activity during the presentation of static 254 

stimuli (“Oscillators;” Figure 7B). The patterned activity was qualitatively deemed to resemble 255 

oscillatory activity, hence the name of these cells. 256 

 257 

Discussion 258 

Further characterization of Xenopus laevis visually-guided behaviors 259 

 Previous studies have examined the initial phototactic choice of tadpoles in forced-choice 260 

procedures. Our work builds on these findings to further characterize color-based behavioral 261 

preferences in Xenopus laevis. We found that, over the course of hour-long trials, Xenopus 262 

tadpoles preferred to swim in green-illuminated areas at a rate higher than chance, even outside 263 

of a forced-choice procedure. This finding provides a more complete picture of visually-guided 264 

behaviors in the Xenopus tadpole and extends our understanding of the innate color preferences 265 

of organisms. 266 

 Additionally, it is an open question whether the green preference exhibited by Xenopus 267 

tadpoles is necessarily a color-based response, or if it is a brightness-based response (Jaeger & 268 

Hailman, 1976). However, the methodology employed here uses a green light that is less bright 269 

than the surrounding white light. Although our methodology does not address initial phototaxis, 270 

we found that over time, tadpoles prefer green despite it being the dimmer of the two stimuli, in 271 

contrast to previous studies of Xenopus phototaxis in which brightness preference overshadowed 272 

any color preference. 273 

 Future research will characterize the nuances of long-term visually-guided behavior. For 274 

example, the long-term attractiveness or aversiveness of colors besides green is as yet 275 

unexamined. Additionally, further controls must be run. An alternative explanation of our 276 

finding is that Xenopus tadpoles simply prefer to swim in the dimmer region of a dish over the 277 

course of an hour. Thus, further experiments will test tadpole preference in a dish in which 75% 278 

is illuminated black and 25% green. The sample size of all-white dish controls will also be 279 

increased, to verify the veracity of our initial finding regarding schooling. Finally, as we only 280 
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tested groups of 10 tadpoles, the preference for green could arise from a slight preference among 281 

all tadpoles or from the averaging of opposing preferences among tadpoles. To further 282 

investigate our observations, future tests will examine individual tadpole behavior, either by 283 

testing solitary tadpoles in the testing apparatus or by tracking the position of individual tadpoles 284 

from recordings involving 10 tadpoles. 285 

 One remaining question is what gives rise to the increased time spent in the green section 286 

of the dish within an individual Xenopus tadpole. One explanation could be that tadpoles simply 287 

cross into the green section more frequently than chance. Another explanation may be that 288 

tadpoles choose to swim only in the green section of the dish, while maintaining the same rate of 289 

swimming. A third possibility is that tadpoles reduce their rate of swimming while in the green 290 

section of the dish. These explanations are certainly not mutually exclusive, but in any case, it is 291 

currently unknown which explanation or combination of explanations gives rise to the 292 

observation of more time spent in the green. Follow-up inquiry will aim to quantify tadpole 293 

swimming speed to begin to address this question. 294 

 295 

Neuronal encoding of colored stimuli 296 

 Our electrophysiology experiments failed to find evidence of color-based processing at 297 

the single-cell level in the optic tectum of the Xenopus tadpole. One of the following two 298 

explanations may account for this result, though this certainly is not an exhaustive list of possible 299 

explanations: (1) Color of visual stimuli is not encoded for at the single-cell level. Perhaps 300 

features such as color are encoded for via circuit dynamics. If this is the case, we believe 301 

oscillator cells are a more likely candidate for involvement in circuit processes that encode for 302 

color, as it is hard to imagine how color might be encoded for by a contrast detector cell that only 303 

receives robust input during changes in luminance contrast. (2) The superficial tectal neurons we 304 

recorded from do not encode for color at all. Consistent with this, it has been found in non-305 

human primates that neurons in the superficial superior colliculus do not show much color-306 

related activity (White et al., 2009). If the Xenopus optic tectum is homologous to the 307 

mammalian superior colliculus in organization, color processing would be expected take place in 308 

the intermediate layers of the optic tectum. 309 

 310 
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 Both explanations may be addressed by Ca2+ imaging. If circuit dynamics encode for 311 

color, different patterns of circuit activity might be identified during the presentation of different 312 

colors by two-photon Ca2+ imaging. Indeed, this technique has previously been used to identify 313 

synchronous oscillatory activity in the Xenopus optic tectum (Imaizumi et al., 2013). Yet if 314 

intermediate, but not superficial tectal neurons encode for color information, then we would 315 

predict to identify robust activity in intermediate, but not superficial tectal neurons during a 316 

transition between equiluminant stimuli. Thus, future research on the neural processing of color 317 

in the Xenopus tadpole will aim to characterize the neural processing of color by two-photon 318 

Ca2+ imaging. 319 

If Ca2+ imaging finds evidence that intermediate tectal neurons encode for color 320 

information, we will utilize our modified tadpole brain preparation (Hamodi & Pratt, 2015) to 321 

further investigate the properties of these neurons. The classic in vivo preparation only allows 322 

access to neurons in the most superficial layer, but this modified preparation would allow us to 323 

record color-evoked responses of neurons from intermediate layers of the tectum. 324 
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Figure 1. Schematic of the green preference behavioral testing procedure. The position of 10 tadpoles was recorded for one hour to 

determine color preference over time. The number of tadpoles in the green and white sections of the dish was counted once per minute 

for one hour, resulting in 60 equally spaced time points counted per test. In this example frame, five tadpoles would be counted as in 

the green section and five in the white section.  



 18 

 
 

 
 

Figure 2. Electrophysiology Procedure and Visual Stimuli. (A) Photograph of the electrophysiology recording rig. A 60X water 

immersion objective was used to visualize tectal neurons while a glass micropipette was used to record from cells. (B) Visual stimuli 

were presented to the tadpole’s eye, filling the entire visual field, while patch clamp recordings were made from neurons in the 

contralateral optic tectum. (C) Sample order of visual stimulus presentation. Visual stimuli consisted of four colors projected onto the 

tadpole’s eye, interleaved with black between each color. Each color was projected for 60 seconds while inter-color black periods had 

a duration of 30 seconds.  
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Figure 3. Sample trace of spontaneous synaptic activity. Spontaneous synaptic events were recorded in patch clamp. Each synaptic 

event captured is a synaptic transmission received by the neuron we are recording from.  
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Figure 4. Heat Map Illustrating Tadpole Positions Over Time. Inset: diagram of the testing dish. The bottom-right corner is the 

green sector of the dish. Tadpoles preferred to swim along the edge of the dish overall. Most time was spent on the edge of the dish in 

the green section (bottom-right 25%), with another area of moderate tadpole presence at the edge of the green section near the center 

of the dish. From least to most tadpole presence during the hour: dark blue, cyan, green, yellow, orange, red, white. 
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Figure 5. Histograms showing theoretical and observed result distributions for green 

preference tests. (A) Theoretical results predicted by the null hypothesis, that tadpoles have no 

preference for or against the color green. Results are clustered around 2.50. (B) Observed 

results from 12 behavioral trials. Results are clustered around 4.00. 
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Figure 6. Average number of tadpoles in the green section over time. The number of tadpoles in the green section of the dish did not 

vary over time. Green squares represent the mean number of tadpoles in the green section at each minute, averaged across trials. 

Error bars indicate the Standard Error of the Mean (SEM). 
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Figure 7. Representative synaptic frequency graphs for the two cell types identified.  
(A) Contrast detector cells receive synaptic input primarily in response to changes in contrast, 

such as a color turning on or off. (B) Oscillator cells receive oscillatory input during the 

presentation of static visual stimuli, such as a static color. Oscillator cells may also, as in the 

representative example, receive input when changes in contrast occur.  
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Appendix A – Heat Map Procedure 

 

1. 30 FPS videos were captured with a GoPro Hero 7 Black or GoPro Hero+ LCD 

2. Videos were concatenated in iMovie and exported as a .mp4 file 

3. Video was converted to .avi file format (NV12 codec) in FFMPEG 

4. The following process was completed in ImageJ: 

a. Video was converted to a 3 FPS .tif stack 

b. Image > Stacks > Z-project > Max Intensity [applied to all slices] 

c. Process > Image Calculator  

i. Image1: [File resulting from step 4a] 

ii. Operation: Difference 

iii. Image2: [File resulting from step 4b] 

d. [Applied to file resulting from step 4c] Image > Stacks > Z-project > Average 

Intensity [applied to all slices] 

e. Process > Image Calculator 

i. Image1: [File resulting from step 4c] 

ii. Operation: Subtract 

iii. Image2: [File resulting from step 4d] 

f. [Applied to file resulting from step 4e] Image > Type > 8-bit 

g. [Applied to file resulting from step 4f] Image > Adjust > Threshold > Adjust as 

necessary [I used MaxEntropy] > Apply 

h. [Applied to file resulting from step 4g] Process > Filters > Mean > 5.0 

i. [Applied to file resulting from step 4h] Image > Stacks > Z-project > Sum Slices 

j. [Applied to file resulting from step 4i] Process > Filters > Mean > 10.0 

k. File > Import > LUTs [I used Royal.lut] 


